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I.   Office 2007 New Interface: 

 
The “Ribbon”    
 

 
 

The “Ribbon” replaces the menus and toolbars.   
 

New graphical user interface which consists of 3 basic components: 
 

1.)  7 basic tabs each relating to certain functions:   

 Home – most common commands: Copy/Paste, Fonts, Styles, 

Find/Replace 

 Insert – adding elements in your document:  Graphs, Pictures, Headers 

&  Footers 

 Page Layout – Themes, Page Setup, Background, Paragraph, Arrange 

 References – Tables of Contents, Footnotes, Bibliography, Captions, 

Index, Table of Authorities 

 Mailings – Envelopes, Label, Mail Merge 

 Review – Spelling & Grammar, Tracking Changes 

 View – Document & Window Views, Show/Hide, Zoom, Macros 

2.)  Tabbed section:  

 groups of related items  

 Click on Home and notice the grouped sections:  Clipboard, Font, 

Paragraph, Styles and Editing 

3.)  Commands:  

 button, box or menu  

 

Minimize the ribbon 
  

Click the Customize Quick Access Toolbar and select minimize the ribbon 
or 

Double click the active tab (Home, Page Layout, References, etc.) to minimize and 

double click any tab to restore the Ribbon 
or 

Press control f1 to minimize and restore the ribbon 
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Dialog Box Launcher 

 
Most tabbed sections will have a 

dialog box launcher which contains 
additional menu options relating to 

that section. 
  

 

Practice:   Use the Dialog Box Launcher to change the font effect to sshhaaddooww: 

 Highlight a title and click on Home 

 Click on the dialog box launcher in the Font section 
 Select shadow and click ok 

 

On Demand Tabs 
 

 
 

Tabs automatically appear when you select certain objects:  picture, chart, table or drawing. 
 
Practice:  Insert a picture and use the on demand tab (Picture Tools) to edit the picture: 

 Click on Insert tab / select Clipart / Search for and select image / click on image 
Notice the Picture Tools tab (sections include adjust, picture style, arrange and 

size) 
 In the Picture Style section, select a frame for your picture 

 Go to Picture Effect and click Reflection and select desired reflection 
 Also check out Picture Border and Picture Shape under Picture Tools/Format 
   

 

II.   Toolbars: 

Mini Toolbar   

 
Common functions are available on the mini toolbar.   
 

The mini toolbar appears when you select and point to highlighted text.  Instead of using the 
function on the ribbon, you can conveniently make the selection from the Mini Toolbar. 
 
Practice: Use the mini toolbar to change your text to Center, Bold and 24 point: 

 Select a paragraph and point to the highlighted text 
 You will see a faded mini toolbar 

 As soon as you point on the toolbar, it becomes solid 
 Select the desired function:  Center, Bold, Font Size 
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Quick Access Toolbar 
 
The quick access toolbar is displayed on 
the top left above the ribbon. 

 
The default functions available on this toolbar are:  Save / Undo / Repeat. 

The Quick Access Toolbar can be customized to add your common functions. 
 

Practice: Customize the Quick Access Toolbar:  

 Click on the Customize Quick Access Toolbar icon 
 Select any option listed to add it to the toolbar 

 or click on More Commands  

Locate the command on the left and double click to select (view command on 

right panel) and click ok 
 

III.   Key Tips:  (Keyboard Shortcuts)  

 

Keyboard shortcuts are now called “KEY TIPS”. 
Many shortcuts are the same as previous versions such as control c to copy and control v to 
paste. 

 

 
 

 
 Press the ALT key to display the Key Tip badges 
 Press ALT again to remove the Key Tip badges 

 
 Every button on the ribbon has a shortcut! 

   
Practice:   Use the Key Tips to insert a table: 

 Press Alt to display the key tips 
 Press N (Insert) / T (Tables) / X (Excel Tables) scroll and select desired table 

 

 

IV.   Office Button:    (similar to File Menu in previous version) 

 

 Lists all commands to work with your document:   
  New, Open, Save, Save As, Print, Prepare, Send, Publish, Close 

 

 Lists frequently used documents on the right 
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 Contains “Word Options” – used to set defaults in Word (replaces 
Tools/Options) 

   
Practice: Change your default to open email attachments in Full Screen Reading view: 

Click on Office Button / Select Word Options / On the Popular tab: check option:  
Open email attachments in Full Screen Reading View 

 
Note: You will want to change your default file location to point to a network location.  Go 

to Word Option/Save. 
  

Print  
 
 Setup: 

Click on the Page Layout tab 

 Page Setup group contains options for Margins, Orientation, Size & Columns 
 
 To Print: 

 Click on the Office Button 
 Click Print to see the print dialog box to specify print options  

 Or 
 Click on the arrow next Print / options include: 

o Print – brings you to the print dialog box 
o Quick Print – sends the document directly to printer (no dialog box shown) 

o Print Preview – preview document before sending to printer 
 

Other Print options: 

 
Save As includes PDF 

Send As include email as attachment or email with XPS format (electronic file format 

which retain all the document formatting.) 
Publish allows you to save your file as a blog post 

Prepare allows you to make your document more secure by using encryption and also 

has a compatibility checker to check for document features not supported by other 

versions. 
  

V.   New File Format (XML format): 

  
 Smaller file size – files are automatically compressed when saved 

 Safer - Less likely to become damaged with this new format 
Better security – documents containing macros are saved with different extension 

than those not containing macros.   
 

Filename.docx:   2007 document without macros 

Template.dotx:   2007 template without macros 

Filename.docm: 2007 document with macros 

Template.dotm: 2007 template with macros 
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Example:  Click on File / Save and check the extension 

The default format is XML 
 

Open documents created on previous Word versions 
 
 Click on the Office Button / Open / double click on file 

 Top of screen will read “Compatibility Mode” next to the document name 

Some features will be turned off when in compatibility mode since the old version 

does not contain the new feature.  Example is Smart Art.   
 

Practice: Open an old document that contains a picture: 

 Click on Insert tab / select Smart Art / only the Diagram Gallery is available 

 If you convert to the new format, all new features are available  

 
NOTE:  Most “older” Microsoft Office versions (2000 sp3, Office XP sp3 & Office 2003 sp1) 

will automatically prompt the user to download a compatibility patch in order to open the 
Office 2007 file.  If the patch has already been installed, the file will just open. 
 
Practice: Convert your “old” document to the new Office 2007 format (XML): 

 Open an “old” document 

Click on the Office Button   
Click on the Save As tab ► 

Click on Word Document (top of the list - the default format is XML) 

Click Save 
Click OK to save document in the new format   

 

 

VI.   Status Bar: 
 

Window frame that displays at the bottom of the screen is the Status Bar 

 
Left side displays the number of pages, words, proofing errors and macros 

Right side displays different page views and the zoom option 
 
Customize the status bar:   

Right click on the status bar and check the desired function  
  

 

Spelling & Grammar 
 
Practice: Spell check your file: 

 Click on the Review tab 
 Click Spelling & Grammar (1st button of left in Proofing group) 
 or 

 Click on Proofing Errors icon  
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 (check bottom left of screen)  
 Red X indicates spelling/grammar errors  

 Green check indicates no spelling/grammar errors  
   

Document Views 

 
Different views of your document 

 Located on the Status (bottom right) and the View tab 

 
 Types of document views: 

 

Print Layout – lets you view how you document will look when printed; can see 

margins;  most popular 

Full Screen Reading – was called Reading Layout in previous versions 

When using full screen can click on View Options button and define various options.   

View Options allows you to read your document in a one or two page view, increase 
font size for reading or allow typing while reading.  

Press Close button to close this view. 
Web Layout – displays document as it would look on the web 

Outline – displays document in an outline 

Draft – shows text only 

 

Zoom 
 
To zoom in and out and see a smaller or larger display of your document: 

 
Click on the zoom slider on the lower right of the screen  
or 

Click on the % amount to view the zoom dialog box 
 or 

 Click on the – or + 
 

VII.   New Features: 

 
Live Preview   

Text changes on the screen automatically so you can see the change before 

committing to it.  Available with fonts, styles, themes, picture tools, etc. 
 

Practice: Use the live preview when selecting a new font: 

 Highlight to select paragraph (triple click) 
 Click on Home tab 

 Click the down arrow in the font box 
 Point to various selections and notice you text change 

 Make your font selection after you have seen the outcome 
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Styles  
Style Sets change the text appearance of the document (styles, colors & fonts). 

You can also select a portion of text and select the desired style. 
 
Practice: Change the Style Set for the whole document: 

 Click Home tab  
 Click on Change Styles from the Styles group 

 Select Style Sets 
 Move over the style to preview and click on the style to select  

 
Practice: Change the style of the headings: 

Highlight the first heading and press control click and drag to select another 
heading 

 Click on Home tab 

 Select Heading 2 in the styles group 

 

Themes  
Themes include combination of colors, fonts and effects   

Allows you to change the appearance of the whole document 
Will not work on document in compatibility mode 

   
Practice: Click on Page Layout tab and click Themes: 

 
If you only want to change the font or color, choose that option from Themes 

group. 
 

Note: Themes work best with documents that contain styles that the themes can update. 

 

SmartArt 
 A new way to define a list or related data with the addition of a graphic element.  

 Communicate your ideas more clearly with SmartArt 
  

Practice:  Insert a SmartArt graphic: 

 Click on Insert tab and select SmartArt 
Scroll through the list of the available graphic options and select desired graphic 

and click OK  
Click on [Text] and enter your data 

 
 
Click on your SmartArt graphic then try the following options: 

To add color:  Click on change colors from the SmartArt Styles group 

Another option for adding text:  Click on the tab arrow on left of SmartArt area 

To specify a new design:  Click the more arrow from the Layouts group 

To specify a different style:  Click the more arrow from the SmartArt styles group 

Install the 
Interactive 

Guide

Use"Get 
Started" 

tab

Select 
Interactive 

Guide
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To change the size of the SmartArt graphic:  Click and drag the outside edge to make 

the area larger or smaller (will get double headed arrow) 

To change the size of SmartArt area:  Click and drag the …. 4 dots on the left, right, 

top or bottom box to increase or decrease the SmartArt area 

 
Note: SmartArt is available in Word, Excel, PowerPoint and Outlook email.   

 Using PowerPoint, you can convert an existing list to a SmartArt list. 
 

 

Galleries 
Galleries contain blocks of data that can be used for headers, footers, cover pages, 
watermarks, table of content and page numbers.  Building Blocks are stored in 

Galleries and contain objects that you save in Word for easy retrieval when needed. 

 

 

Quick Parts Gallery  
Makes it easy to save and reuse commonly used data and images. 
 

Practice: Save a commonly used closing paragraph to the Quick Parts Gallery: 

 Highlight a paragraph and click on the Insert tab 

 Select Quick Parts 
 Select Save Selection to Quick Parts Gallery 
 

 Recall your stored information: 
 Click on Insert tab / click on Quick Parts / Select your data 

 
Notes: When you exit Word, you need to click “yes” to save your building block 

information. 
 
Check out: 

Cover Page Gallery:  Go to Insert / Cover Page / Make selection 
Footer Gallery: Go to Insert / Footer /make selection / click on close header/footer 

 
 

VIII.   HELP!!! 
 

 Press F1 to get help!  Search for any topic 

 Click the ? on top right  

 Go to http://office.microsoft.com/en-us/training/HA102295841033.aspx 
 

 Interactive Guides – available for Word, Excel & PowerPoint 

If the guide is already installed, you will see a tab on the Ribbon labeled, 
 “Get Started”. 

To install a guide: Go to the Microsoft.com site 

Enter “Get Started Tab” in the search box on the right 

Click on the first link 

http://office.microsoft.com/en-us/training/HA102295841033.aspx
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Scroll to the heading “Get it now” and select the desired guide 
Click Continue/Download/Run/Run 

When the installation is complete, you will run the Office program and see 
the get started tab on the ribbon. 

 To use the guide:  Click on Get Started tab / Interactive Guide 

  Click on Start the Guide / click Start 

  A 2003 screen is presented.  Select your function  
  The 2007 commands will be shown / notice the yellow boxes  
 

 Go to www.microsoft.com  
o Microsoft site has training, reference guides, interactive 2003 2007 

guide, presentations, demos, blogs, etc. 
o Search  “office 2007 home page” 

o Also check out Workbook Mapping 
 

 
 

http://www.microsoft.com/

